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About the BlackBerry Web Desktop Manager

About the BlackBerry Web
Desktop Manager

1

The BlackBerry Web Desktop Manager is a web-based application that you can use to manage specific features of your
BlackBerry devices. Your system administrator can provide you with the web address for the BlackBerry Web Desktop
Manager and the required login information.
Some of the actions that you can perform using the BlackBerry Web Desktop Manager are:
•

Activate one or more devices by connecting a device to your computer

•

Create an activation password for a wireless activation

•

Switch the services from your current device to a new device

In case your device is lost or stolen, you can:
•

Change the device password remotely

•

Delete data from a device remotely
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Requirements: Browser
•

Windows Internet Explorer 8.0

•

Mozilla Firefox 10 and later

•

Google Chrome 12 and later

To activate your device using a wired connection to your computer, you must use Windows Internet Explorer.

Log in to the BlackBerry Web Desktop
Manager
Before you begin:
• Your administrator will provide you with the web address for the BlackBerry Web Desktop Manager, a username, a
password, and if necessary, your organization's domain name (for example, the Windows domain).
•

In Windows Internet Explorer, add the BlackBerry Web Desktop Manager web address to the list of trusted web sites.

1.

Navigate to the BlackBerry Web Desktop Manager web address that your system administrator provided you with.

2.

Type your username and password.

3.

If the domain name is not already present, type your organization's domain name.

4.

Click Log in. The first time you log in to BlackBerry Web Desktop Manager, the browser might prompt you to accept a
client authentication certificate and install the files that you need to use the BlackBerry Web Desktop Manager. To
install these files, you must have local administrator permissions for your computer.
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Troubleshooting: Getting started
My computer cannot detect my device
Try performing the following actions:
•

Verify that your device is connected to your computer.

•

If you are trying to connect your device to your computer using a USB cable, verify that the USB cable is not damaged.

•

Turn off synchronization programs or antivirus programs temporarily.

•

Verify that you are not running software that scans the communications ports on your computer.

I cannot access the features of the BlackBerry Web
Desktop Manager
If the features of the BlackBerry Web Desktop Manager are unavailable because the necessary controls are not installed,
try performing the following actions:
•

See the system requirements for the BlackBerry Web Desktop Manager in the BlackBerry Enterprise Server Installation
and Configuration Guide. To download this guide, visit www.blackberry.com/go/serverdocs/.

•

Contact your administrator.
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Activating your device
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Activate a new device using a wired
connection to your computer
1.

Log in to the BlackBerry Web Desktop Manager.

2.

Connect your BlackBerry device to your computer using a USB cable.

3.

If the Device Security Password field appears on your computer, type the device password. Click OK. The activation
process begins automatically.

4.

When the activation process completes, click OK and disconnect your device.

Activate a new device over the wireless
network
Before you begin: Verify that you have an activation password. Your administrator might provide one, or you can create
one.
1.

On your device, click Options > Device > Advanced System Settings > Enterprise Activation .

2.

In the Email field, type your email address.

3.

In the Activation Password field, type the password that your administrator provided, or the password that you
created.

4.

Click Activate.

8

User Guide

Activating your device

Create an activation password
If you need to activate your BlackBerry device, and you did not receive an activation password from your administrator or
the activation password expired, you can create an activation password and activate your device over the wireless network.
1.

On the Home tab, click Create an Enterprise Activation Password.

2.

In the Enterprise activation password field and the Confirm password field, type a password.

3.

Click Set the enterprise activation password.

After you finish: Activate your device over the wireless network.
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4

Change the device password
If you misplace your BlackBerry device but think you might be able to recover it, you can use the BlackBerry Web Desktop
Manager to remotely change the password for the device and lock the device to keep your data secure. Depending on your
organization's security policies, you might not be able to remotely change the password and lock the device.
1.

On the Home tab, click Secure a Lost Device.

2.

Click Specify new device password and lock device.

3.

In the Device password field, type your new device password.

4.

In the Confirm password field, type your new password again.

5.

Click Specify new device password and lock device.

Delete all the data on your device
If you misplace or lose your BlackBerry device, you can use the BlackBerry Web Desktop Manager to remotely delete all
the data on your device. When you delete the data on your device, your device is deactivated. Depending on your
organization's security policies, you might not be able to complete this task.
1.

On the Home tab, click Secure a Lost Device.

2.

Click Delete all device data and disable device.

3.

Click Yes.

Note: If you find your device, you can activate your services again by either connecting your device to your computer using
a USB cable or by creating an activation password so that you can activate your device over the wireless network.
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Back up device data
1.

Connect your device to your computer.

2.

On the Backup and Restore tab, perform one of the following actions:
•

To back up all your device data, click Back up.

•

To back up specific device data, click Advanced. In the Device Databases section, click a database. Click the
Left Arrow icon. On the File menu, click Save As.

•

If your device contains on-board device memory, to back up files that you saved to your device, verify that mass
storage mode is turned on. Click Configure Backup Options. Select the Back up on-board device memory check
box. Click Save. Click Back Up and Restore Now to continue backing up device data.

Schedule automatic backups of device data
1.

Connect your device to your computer.

2.

On the Backup and Restore tab, click Configure Backup Options.

3.

Select the Automatically back up my device check box.

4.

Set how often automatic backup should occur.

5.

Perform one of the following actions:

6.

•

If your device contains on-board device memory, to back up files that you saved to your device, verify that mass
storage mode is turned on. Select the Back up on-board device memory check box.

•

To back up all device data, select the Backup all device application data option.

•

To exclude email messages or organizer data, select the Backup all device application data, except for option.
Specify the type of data to exclude.

Click Save.
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Restore device data
1.

Connect your BlackBerry device to your computer.

2.

On the Backup and Restore tab, perform one of the following actions:
•

To restore all the device data in a backup file, click Restore. Double-click a backup (.bbb) file.

•

To restore specific device data from a backup file, click Advanced. On the File menu, click Open. Double-click a
backup (.bbb) file. In the Desktop File Databases section, click a database. Click the Right Arrow icon.

Troubleshooting: Backup and restore
I cannot restore some device data
Try the following actions:
•

Verify that the database that you are trying to restore does not appear dimmed in the Device Databases section. If the
database appears dimmed and the Right Arrow icon is not available, your device might be configured for wireless
synchronization, wireless backup might be turned on, or the database might be read-only. For more information,
contact your administrator.

•

Verify that your device has enough available memory to store the database. The amount of memory that appears beside
the database in the Desktop File Databases section might differ from the amount of memory that is required to store
the database on your device. If the application memory on your device is low, consider deleting unused applications,
old data, or old messages from your device.

Error messages: Backup and restore
The Backup
functionality is not
available at your
current location.

This message appears if you log in to the BlackBerry Web Desktop Manager from a computer
that your administrator has restricted from performing backup and restore functions. For more
information, contact your administrator.

This function is no
longer available to

This message appears if your administrator has changed your permissions since you logged in to
the BlackBerry Web Desktop Manager. For more information, contact your administrator.
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you. No changes
have been made.
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Email messages settings
Stop forwarding email messages to your device
1.

On the Email Settings tab, clear the Redirect incoming email messages to the device check box.

2.

Click Save.

Add a signature
1.

On the Email Settings tab, in the Signature box, type a signature.

2.

Click Save.

Delete your signature
1.

On the Email Settings tab, in the Signature box, delete the signature.

2.

Click Save.

Store messages sent from your device on your
messaging server
1.

On the Email Settings tab, select the Save copy in Sent folder when sending an email message from the BlackBerry
device check box.

2.

Click Save.
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Add contacts to your device from your email message
folders
You can add private or corporate contact folders that appear in the email application on your computer to the contact list
on your device. The corporate contact folders are published by your administrator.
1.

On the Email Settings tab, click Contact Folders.

2.

Perform any of the following actions:

3.

•

In the Private contact folders section, select the check box beside one or more personal contact folders that you
want to add to the contact list on your device.

•

In the Default private contact folder section, in the Default contact folder drop-down list, click a personal folder
to synchronize with your device. When you add a new contact on your device, it is added to this folder.

Click Save.

Forward messages from a specific email message
folder to your device
1.

On the Email Settings tab, click Redirection Folders.

2.

Perform one of the following actions:

3.

•

To receive email messages from your inbox on your device, select the check box beside Inbox.

•

To receive email messages from your sent items folder on your device, select the check box beside Sent Items.

•

To specify additional email message folders, select the check box beside one or more folders.

Click Save.

Delivery status for email messages and organizer data
If your device is connected to your computer, from the Advanced Settings tab, you can view the service statistics for your
email messages and organizer data items.
Messages
forwarded

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server has forwarded to your device.
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Messages sent

This field displays the number of email messages and organizer data items that you have sent
from your device.

Messages pending

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server has not yet forwarded to your device. If your device is not connected to the
wireless network, the BlackBerry Enterprise Server queues email messages and organizer data
items for up to 7 days and forwards them when your device is connected to the wireless network
again.

Messages expired

This field displays the number of email messages and organizer data items that the BlackBerry
Enterprise Server could not forward to your device within 7 days. These email messages and
organizer data items remain in the email application on your computer.

Messages filtered

This field displays the number of email messages that the BlackBerry Enterprise Server did not
forward to your device because your email message filters prevented redirection or because your
device was connected to your computer.

Add contacts from your organization's contact list to
your device
You can add private or corporate contact folders that appear in the email application on your computer to the contact list
on your device. The corporate contact folders are published by your administrator.
1.

On the Email Settings tab, click Contact Folders.

2.

Perform any of the following actions:

3.
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•

In the Private contact folders section, select the check box beside one or more personal contact folders that you
want to add to the contact list on your device.

•

In the Default private contact folder section, in the Default contact folder drop-down list, click a personal folder
to synchronize with your device. When you add a new contact on your device, it is added to this folder.

Click Save.
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Email message filters
About email message filters
You can create email message filters to specify which email messages are forwarded to your device and which remain in
the email application on your computer.
Email message filters are applied to email messages based on the order in which they appear in your list of email message
filters. If you create multiple email message filters that could apply to the same email message, you must decide which one
should be applied first by placing that filter higher in the list.

Create an email message filter
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click Add new email message filter.

3.

Set the email message filter options.

4.

To select contacts or distribution lists from your organization's contact list, click the Import list icon beside the From
or Sent to fields.

5.

Click Add New Filter.

6.

Click Save.

Options for email message filters
Filter name:

Type a unique name for the new filter.

From:

Specify one or more contacts or email addresses that the email message filter should search for
in the From field of email messages. Separate multiple contacts or email addresses with a
semicolon (;). To specify that the email message filter should search for all email addresses that
contain specific text, type the text and use an asterisk (*) as a wildcard character to represent
the rest of the email address.

Sent to:

Specify one or more contacts or email addresses that the email message filter should search for
in the Sent To field of email messages. Separate multiple contacts or email addresses with a
semicolon (;). To specify that the email message filter should search for all email addresses that
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contain specific text, type the text and use an asterisk (*) as a wildcard character to represent
the rest of the email address.
Subject:

Type the text that the email message filter should search for in the Subject field of email
messages.

Body:

Type the text that the email message filter should search for in the body of email messages.

Sent directly to me:

Set whether the email message filter applies to email messages that include your email address
in the To field.

CC: to me:

Set whether the email message filter applies to email messages that include your email address
in the CC field.

BCC: to me:

Set whether the email message filter applies to email messages that include your email address
in the BCC field.

Importance:

Set the importance level of email messages that the email message filter applies to.

Sensitivity:

Set the sensitivity level of email messages that the email message filter applies to.

Forward messages
to the device:

Select this option to forward email messages that the email message filter applies to your device.
Specify whether email messages are forwarded with high importance or with the email message
header only.

Do not forward
messages to the
device:

Select this option to prevent email messages that the email message filter applies to from being
forwarded to your device.

Add a contact from your organization's contact list to
an email message filter
You can import contacts from your organization's contact list into an email message filter.
1.

When creating or changing an email message filter, click the Import list icon beside the From or Sent to fields.

2.

In the Search Users section, perform one of the following actions:
•

In the Messaging server display name field, type the user display name for the contact on your organization's
messaging server.

•

In the Email address field, type part or all of the email address for the contact.

3.

Click Search.

4.

In the search results, select the check box beside the contact.

5.

Click Next to continue creating or changing your email message filter.
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Change an email message filter
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click an email message filter.

3.

Change the email message filter options.

4.

To select contacts or distribution lists from your organization's contact list, click the Import list icon beside the From
or Sent to fields.

5.

Click Update Filter.

6.

Click Save.

Change the order of email message filters
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click the Up Arrow icon or the Down Arrow icon.

3.

Click Save.

Turn off an email message filter
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click the checkmark icon beside an email message filter.

3.

Click Save.

Delete an email message filter
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click the minus sign icon beside an email message filter.

3.

Click Save.

Save all email message filters
1.

On the Email Settings tab, click Email Filter Settings.
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Click Save Filters.

Open a saved email message filter
1.

On the Email Settings tab, click Email Filter Settings.

2.

Click Load Filters.

3.

Click an email message filter (.rfi) file.

4.

Click Open.

Troubleshooting: Email settings
I cannot send or receive email messages on my device
Try performing the following actions:
•

Verify that your device is connected to the wireless network.

•

Verify that email message forwarding is turned on and that you have selected all the email message folders, including
your inbox folder, that you want to receive email messages from.

•

If you have generated a new encryption key, connect your device to your computer to share the encryption key.

•

Verify that your email profile options are correct. For more information, contact your administrator.
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About switching devices
You can use the switch device wizard to transfer data and services from your current BlackBerry device to a new
BlackBerry device.
The switch device wizard is designed to transfer supported organizer data, messages, third-party applications, and
BlackBerry Enterprise Server connection options from your current device to your new device. The switch device wizard
also starts the activation process for your new device. During the activation process, BlackBerry services, such as email
reconciliation, are transferred to your new device.

Switch devices
1.

Connect your new device to your computer, or connect both your current device and new device to your computer.

2.

Click Yes - Switch my BlackBerry services to this device.

3.

Click Yes - Transfer the data.

4.

Complete the instructions on the screen.

After you finish: Do not disconnect your device from your computer until your device data and services have been
switched and the activation process on your new device is complete. The process is complete when the Change devices
screen appears on your computer.
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©2013 Research In Motion Limited. All rights reserved. BlackBerry®, RIM®, Research In Motion®, and related trademarks,

names, and logos are the property of Research In Motion Limited and are registered and/or used in the U.S. and countries
around the world.
Google Chrome is a trademark of Google Inc. Microsoft and Windows are trademarks of Microsoft Corporation. Mozilla and
Firefox are trademarks of Mozilla Foundation. All other trademarks are the property of their respective owners.
This documentation including all documentation incorporated by reference herein such as documentation provided or
made available at www.blackberry.com/go/docs is provided or made accessible "AS IS" and "AS AVAILABLE" and without
condition, endorsement, guarantee, representation, or warranty of any kind by Research In Motion Limited and its affiliated
companies ("RIM") and RIM assumes no responsibility for any typographical, technical, or other inaccuracies, errors, or
omissions in this documentation. In order to protect RIM proprietary and confidential information and/or trade secrets, this
documentation may describe some aspects of RIM technology in generalized terms. RIM reserves the right to periodically
change information that is contained in this documentation; however, RIM makes no commitment to provide any such
changes, updates, enhancements, or other additions to this documentation to you in a timely manner or at all.
This documentation might contain references to third-party sources of information, hardware or software, products or
services including components and content such as content protected by copyright and/or third-party websites
(collectively the "Third Party Products and Services"). RIM does not control, and is not responsible for, any Third Party
Products and Services including, without limitation the content, accuracy, copyright compliance, compatibility,
performance, trustworthiness, legality, decency, links, or any other aspect of Third Party Products and Services. The
inclusion of a reference to Third Party Products and Services in this documentation does not imply endorsement by RIM of
the Third Party Products and Services or the third party in any way.
EXCEPT TO THE EXTENT SPECIFICALLY PROHIBITED BY APPLICABLE LAW IN YOUR JURISDICTION, ALL CONDITIONS,
ENDORSEMENTS, GUARANTEES, REPRESENTATIONS, OR WARRANTIES OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY CONDITIONS, ENDORSEMENTS, GUARANTEES, REPRESENTATIONS OR
WARRANTIES OF DURABILITY, FITNESS FOR A PARTICULAR PURPOSE OR USE, MERCHANTABILITY, MERCHANTABLE
QUALITY, NON-INFRINGEMENT, SATISFACTORY QUALITY, OR TITLE, OR ARISING FROM A STATUTE OR CUSTOM OR A
COURSE OF DEALING OR USAGE OF TRADE, OR RELATED TO THE DOCUMENTATION OR ITS USE, OR PERFORMANCE
OR NON-PERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
REFERENCED HEREIN, ARE HEREBY EXCLUDED. YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY BY STATE OR
PROVINCE. SOME JURISDICTIONS MAY NOT ALLOW THE EXCLUSION OR LIMITATION OF IMPLIED WARRANTIES AND
CONDITIONS. TO THE EXTENT PERMITTED BY LAW, ANY IMPLIED WARRANTIES OR CONDITIONS RELATING TO THE
DOCUMENTATION TO THE EXTENT THEY CANNOT BE EXCLUDED AS SET OUT ABOVE, BUT CAN BE LIMITED, ARE
HEREBY LIMITED TO NINETY (90) DAYS FROM THE DATE YOU FIRST ACQUIRED THE DOCUMENTATION OR THE ITEM
THAT IS THE SUBJECT OF THE CLAIM.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, IN NO EVENT SHALL RIM BE
LIABLE FOR ANY TYPE OF DAMAGES RELATED TO THIS DOCUMENTATION OR ITS USE, OR PERFORMANCE OR NONPERFORMANCE OF ANY SOFTWARE, HARDWARE, SERVICE, OR ANY THIRD PARTY PRODUCTS AND SERVICES
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REFERENCED HEREIN INCLUDING WITHOUT LIMITATION ANY OF THE FOLLOWING DAMAGES: DIRECT,
CONSEQUENTIAL, EXEMPLARY, INCIDENTAL, INDIRECT, SPECIAL, PUNITIVE, OR AGGRAVATED DAMAGES, DAMAGES
FOR LOSS OF PROFITS OR REVENUES, FAILURE TO REALIZE ANY EXPECTED SAVINGS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, LOSS OF BUSINESS OPPORTUNITY, OR CORRUPTION OR LOSS OF DATA,
FAILURES TO TRANSMIT OR RECEIVE ANY DATA, PROBLEMS ASSOCIATED WITH ANY APPLICATIONS USED IN
CONJUNCTION WITH RIM PRODUCTS OR SERVICES, DOWNTIME COSTS, LOSS OF THE USE OF RIM PRODUCTS OR
SERVICES OR ANY PORTION THEREOF OR OF ANY AIRTIME SERVICES, COST OF SUBSTITUTE GOODS, COSTS OF
COVER, FACILITIES OR SERVICES, COST OF CAPITAL, OR OTHER SIMILAR PECUNIARY LOSSES, WHETHER OR NOT
SUCH DAMAGES WERE FORESEEN OR UNFORESEEN, AND EVEN IF RIM HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW IN YOUR JURISDICTION, RIM SHALL HAVE NO OTHER
OBLIGATION, DUTY, OR LIABILITY WHATSOEVER IN CONTRACT, TORT, OR OTHERWISE TO YOU INCLUDING ANY
LIABILITY FOR NEGLIGENCE OR STRICT LIABILITY.
THE LIMITATIONS, EXCLUSIONS, AND DISCLAIMERS HEREIN SHALL APPLY: (A) IRRESPECTIVE OF THE NATURE OF
THE CAUSE OF ACTION, DEMAND, OR ACTION BY YOU INCLUDING BUT NOT LIMITED TO BREACH OF CONTRACT,
NEGLIGENCE, TORT, STRICT LIABILITY OR ANY OTHER LEGAL THEORY AND SHALL SURVIVE A FUNDAMENTAL
BREACH OR BREACHES OR THE FAILURE OF THE ESSENTIAL PURPOSE OF THIS AGREEMENT OR OF ANY REMEDY
CONTAINED HEREIN; AND (B) TO RIM AND ITS AFFILIATED COMPANIES, THEIR SUCCESSORS, ASSIGNS, AGENTS,
SUPPLIERS (INCLUDING AIRTIME SERVICE PROVIDERS), AUTHORIZED RIM DISTRIBUTORS (ALSO INCLUDING AIRTIME
SERVICE PROVIDERS) AND THEIR RESPECTIVE DIRECTORS, EMPLOYEES, AND INDEPENDENT CONTRACTORS.
IN ADDITION TO THE LIMITATIONS AND EXCLUSIONS SET OUT ABOVE, IN NO EVENT SHALL ANY DIRECTOR,
EMPLOYEE, AGENT, DISTRIBUTOR, SUPPLIER, INDEPENDENT CONTRACTOR OF RIM OR ANY AFFILIATES OF RIM
HAVE ANY LIABILITY ARISING FROM OR RELATED TO THE DOCUMENTATION.
Prior to subscribing for, installing, or using any Third Party Products and Services, it is your responsibility to ensure that
your airtime service provider has agreed to support all of their features. Some airtime service providers might not offer
Internet browsing functionality with a subscription to the BlackBerry® Internet Service. Check with your service provider for
availability, roaming arrangements, service plans and features. Installation or use of Third Party Products and Services with
RIM's products and services may require one or more patent, trademark, copyright, or other licenses in order to avoid
infringement or violation of third party rights. You are solely responsible for determining whether to use Third Party
Products and Services and if any third party licenses are required to do so. If required you are responsible for acquiring
them. You should not install or use Third Party Products and Services until all necessary licenses have been acquired. Any
Third Party Products and Services that are provided with RIM's products and services are provided as a convenience to you
and are provided "AS IS" with no express or implied conditions, endorsements, guarantees, representations, or warranties
of any kind by RIM and RIM assumes no liability whatsoever, in relation thereto. Your use of Third Party Products and
Services shall be governed by and subject to you agreeing to the terms of separate licenses and other agreements
applicable thereto with third parties, except to the extent expressly covered by a license or other agreement with RIM.
Certain features outlined in this documentation require a minimum version of BlackBerry Enterprise Server, BlackBerry
Desktop Software, and/or BlackBerry Device Software.
The terms of use of any RIM product or service are set out in a separate license or other agreement with RIM applicable
thereto. NOTHING IN THIS DOCUMENTATION IS INTENDED TO SUPERSEDE ANY EXPRESS WRITTEN AGREEMENTS OR

23

User Guide

WARRANTIES PROVIDED BY RIM FOR PORTIONS OF ANY RIM PRODUCT OR SERVICE OTHER THAN THIS
DOCUMENTATION.
Research In Motion Limited
295 Phillip Street
Waterloo, ON N2L 3W8
Canada
Research In Motion UK Limited
200 Bath Road
Slough, Berkshire SL1 3XE
United Kingdom
Published in Canada

24

Legal notice

